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FILE PREPERATION

Before going into the Print Menu, we need to check and make sure that settings for ICC profiles
are properly set, and that you file is sized correctly for your paper size. Your monitors are color calibrated
to give you the best possible comparison between your print and what you see on your screen. Your
monitor ICC profile needs to be selected by YOU. The profile you need to select is posted on the
whiteboard in class, this will change periodically throughout the semester.

Changing the Monitor ICC Profile:

This should be done before you are doing any corrections to your image. You will only need to
do this one time every time the ICC profile changes.

1. Open the Monitor Preferences and select the color tab.
2. Select from the list the current custom ICC Profile.

2.1. ltis usually a date in this format: YEARMODAY .icc (01/15/2019 = 20190115.icc)
3. Once you select it and it is highlighted you can close out the display preference window.

If you are just now doing this it may affect your image.

SYSTEM DISPLAY PREFERENCE WINDOW
[ ] < i DELL U2413 Q

Display | Color | Night Shift

Display profile:

04032018.icc Open Profile
1M272017.0cc

832018./ce Delete Profile
DE5_201801291217.icc Calibrate..
DELL U2413

DELL U2413_D65_201708151025.icc
DELL U2413_D65_201708151054.icc
| DELL U2413_D65_201708151054.icc
DELL U2413_D65_201810250925.icc
DELL U2413_D65_201901070855.icc

Show profiles for this display only

AirPlay Display: Off ‘J

| Show mirroring options in the menu bar when available
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Image Size

Before you send your file to the printer you also need to know that it will fit on the size paper you
selected. We do not print boarderless (full-bleed) in the photo lab, so you need to have a larger sheet of
paper then the size of your print. If you want a 8x10” print your paper needs to be at least 8.5x11” (letter
size).

Image Re-sizing:

Always check to make sure your file is sized correctly to print.

Image>Image Size, brings up the Image Size dialog box (fig 2a).

Make sure that your Width and Height are correct and will fit on the your paper with a boarder.
Your resolution will be either 300ppi or 240ppi.

Once you have the image the correct size you are now ready to print.

agrwONRE

Image Size Dialog Box (Image>Image Size

Image Size: 20.6M
Dimensions: v 2400 px x 3000 px
Fit To: Original Size
Width: 8 Inches
¢

Height: 10 Inches

Resolution: 300 Pixels/Inch

Resample:  Automatic

Cancel
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PRINTING
NOTE: ART-142is to only use EPSON Ultra Premium Luster, Epson Premium Glossy or Epson

Presentation Matte paper. This is due to chooseing ICC print profiles and which papers are loaded into
each system. Art-242, you will have more freedom with paper type and custom profiles.

From the menu bar, click File > Print. You will come to a menu that looks like the following:

1.
o Print Settings
85k x11n Printer Setup
Printer: A BDE-205-Epson-SP4900-1 :| &
Copies: |1 Print Settings...
Layout: \@L—i'l

¥ Color Management
Remember to enable the printer's color
management in the print settings dialog box.
Document Profile: Adobe RGB (1998)

Color Handling: | Printer Manages Colors

Printer Profile:  sRG8 IECE
Send 16-bit Data

Normal Printing *
Rendering Intent: | Relative Colorimetric  +

Black Point Compensatiol

¥ Description

¥ Position and Size
Position

V| Center Top: Left:

Show Paper White .
Cancel Done | Print

Match Print Colors || Gamut Warning

2. Under Printer Setup, choose the printer you are going to print to and the orientation of your
image.

Printer Setup

Printer: | BDE-205-Epson-SP4900-1 ]
Copies: |1 | | Print Settings...
Layout: E:I

3. Under the Color Management tab, in Color Handling: select Photoshop Manages Colors.
NOTE: Make sure your Document Profile is Adobe RGB (1998), it may also say SRGB depending

on how you process your images in camera raw.
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¥ Color Management
Remember to disable the printer's color
management in the print settings dialog box.

Document Profile: Adobe RGE (1998)

Color Handling: ‘ Photoshop Manages Colors ¢‘

Printer Profile: ‘ Epson Stylus Pro 4900_4910 Premium... 3‘

Send 16-bit Data

Normal Printing =

Rendering Intent: ‘ Relative Colorimetric =

[+] Black Point Compensation

4. Under Printer Profile choose your corresponding ICC profile for the paper you are using. You
may need to look this up on the manufacturer's website. Make sure your profile corresponds to
your printer

Epson Stylus Pro 4900_4910 ArchivalMattePaper_MK {
Epson Stylus Pro 4900_4910 ArchivalMattePaper_PK

Epson Stylus Pro 4900_4910 EnhancedMattePaper_MK

Epson Stylus Pro 4900_4910 EnhancedMattePaper_PK

Epson Stylus Pro 4900_4910 EpsonProofingPaperCommercial
Epson Stylus Pro 4900_4910 EpsonProofingPaperPublication
Epson Stylus Pro 4900_4910 EpsonProofingPaperWhiteSemimatte
Epson Stylus Pro 4900_4910 PhotoPaperGloss250

| Epson Stylus Pro 4900_4910 PhotoQualityinkJetPaper

Epson Stylus Pro 4900_4910 PremiumGlossyPhotoPaper

Epson Stylus Pro 4900_4910 PremiumGlossyPhotoPaper170

| Epson Stylus Pro 4900_4910 PremiumGlossyPhotoPaper250
Epson Stylus Pro 4900_4910 PremiumLusterPhotoPaper

| Epson Stylus Pro 4900_4910 PremiumLusterPhotoPaper260

! Epson Stylus Pro 4900_4910 PremiumSemiglossPhotoPaper

: Epson Stylus Pro 4900_4910 PremiumSemiglossPhotoPaper170

|

Epson Stylus Pro 4900_4910 PremiumSemiglossPhotoPaper250
Epson Stylus Pro 4900_4910 PremiumSemimattePhotoPaper260
Epson Stylus Pro 4900_4910 SingleweightMattePaper

Epson Stylus Pro 4900_4910 Standard

Epson Stylus Pro 4900_4910 TexturedFineArtPaper_MK

Epson Stylus Pro 4900_4910 TexturedFineArtPaper_PK

Epson Stylus Pro 4900_4910 UltraSmoothFineArtPaper_MK
Epson Stylus Pro 4900_4910 UltraSmoothFineArtPaper_PK
Epson Stylus Pro 4900_4910 VelvetFineArtPaper_MK

Epson Stylus Pro 4900_4910 VelvetFineArtPaper_PK

Epson Stylus Pro 4900_4910 WatercolorPaper-RadiantWhite_MK
Epson Stylus Pro 4900_4910 WatercolorPaper-RadiantWhite_PK
Epson_SP4900_Cold_Press_Bright_MK_v1

| Epson_SP4900_Cold_Press_Natural_MK_v2

| Epson_SP4900_Exhibition_Canvas_Gloss_PK_v1

| Epson_SP4900_Exhibition_Canvas_Matte_MK_v1
Epson_SP4900_Exhibition_Canvas_Natural_Gloss_PK_v1
Epson_SP4900_Exhibition_Canvas_Natural_Matte_MK_v3
Epson_SP4900_Exhibition_Canvas_Natural_Satin_PK_v1
Epson_SP4900_Exhibition_Canvas_Satin_MK_v1
Epson_SP4900_Exhibition_Fiber_Paper_PK_v1
Epson_SP4900_Hot_Press_Bright_MK_v1
Epson_SP4900_Hot_Press_Natural_MK_v1
Epson_SP4900_Premium_Canvas_Matte_MK_v2
Epson_SP4900_Premium_Canvas_Satin_MK_v1
Epson_SP4900_Standard_Proofing_Paper_205_PK_v1
Epson_SP4900_Standard_Proofing_Paper_240_PK_v1
Epson_SP4900_Standard_Proofing_Paper_Adhesive_PK_v1
Epson_SP4900_Standard_Proofing_Paper_Production_PK_v1
Epson_SP4900_Standard_Proofing_Paper_SWOP3_PK_v1
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5. Under Rendering Intent make sure Relative Colorimetric is selected. Only choose Perceptual
for overly color-saturated images. Do not use Saturation or Absolute Colorimetric. These

settings are not for printing photographic images.

6. Make sure to check Black Point Compensation.

7. Look under the preview of your image and make sure all of these options are unchecked: Match

Print Colors, Gamut Warning, and Show Paper White.

[_] Match Print Colors Gamut Warning Show Paper White

Please Note:

Printers that print on photo paper with photo black ink:

BDE-205-Epson-SP4900-1
BDE-205-Epson-SP4900-2
BDE-205-Epson-SP4900-3
BDE-205-Epson-SP4900-4

Printers that print on matte paper with matte black ink:

BDE-205-Epson-SP4900-5

Printers that print all black selenium inks on photo paper only:

Cancel| | Dane | | Print

BDE-205-Epson-4880-Piezo
*Please see Photo lab coordinator for specific paper type to use.

PRINTING PART 2 — EPSON PRINTER DRIVER

8. Go back to the top of the dialogue box under Printer Setup and click on Print Settings.

Print

Printer: | BDE-205-Epson-SP4900-1 =

Copies: |1

Pages: | Single 3| 1 -

( ? | | PDF « Show Details Cancel | Save |
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9. Make sure your preset is Default Settings.

Print

Printer: = BDE-205-Epson-SP4900-1 B

Presets: Default Settings

Copies: 1

Paper Size: = US Letter (Sheet - Maximum) ﬂ 8.50 by 11.00 inches

Printer Settings | <]

g

Advanced Color Settings

Page Setup: Sheet - Maximum
Manual Feed

Media Type: Ultra Premium Photo Paper Luster

‘m‘m‘

Ink: | Photo Black
Print Mode: DR 5 16 Bit Output
Color Mode:

Output Resolution: = SuperPhoto - 1440 dpi ﬂ

olor Manageme... {

Super MicroWeave
High Speed
Mirror Image

Finest Detail

.. Print quality near the bottom edge may decline or the area may be smeared
depending on the media. For details about this setting, see online help or your
Reference Guide.

? PDFﬁ Hide Details 4 Low Ink Cancel

10. Choose your paper size for whatever paper you are printing on (choose US Letter (Sheet
Maximum) for all 8.5” x 11” paper this gives you minimal margin 0.12” on each side and your
image should be able to print centered).

NOTE: The size of your image needs to be smaller than the paper size. This should be changed
BEFORE the print menu in Photoshop under Image = Image Size. Do NOT change your
image size in the print menu. Do NOT check Scale to Fit Media.

11. The next drop-down box under your paper size, make sure to select Printer Settings.

12. Under the Basic Tab is where the next several steps will take place.
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Printer Settings

Advanced Color Settings |

Page Setup: Sheet

Media Type: | Ultra Premium Photo Paper Luster

Ink: | Photo Black

Print Mode: | AccuPhoto HDR
Color Mode: | Off (No Color Manage
Output Resolution: | SuperPhoto - 2880 dpi
v Super MicroWeave
High Speed
Mirror Image
@]Finest Detail

(2) | POF » Hide Details

13. Under Page Setup: Sheet, make sure to select Manual Feed.

16 Bit Output

Cancel l Save

14. Select the Media Type for your paper. It should be similar to the name of your paper. When in

doubt, please ask.

For Luster or Glossy papers:

Proofing Paper
Fine Art Paper
Matte Paper
Plain Paper

v

YyYYyYvyy

1: | SuperPhoto - 1440 dpi & |

[E]Super MicroWeave
™ High Speed

[_| Mirror Image

|| Finest Detail

For Matte paper:

Photo Paper >

Proofing Paper >

Fine Art Paper >

Plain Paper >
: | AccuPhoto HDR + | ] 16 Bit Output

: | Off (No Color Manage... v

e —————

Premium Luster Photo Paper (260)
Premium Glossy Photo Paper (250)
Premium Semigloss Photo Paper (250)
Premium Semimatte Photo Paper (260)
Premium Glossy Photo Paper (170}
Premium Semigloss Photo Paper (170)
Premium Photo Paper Glossy
Premium Photo Paper Semi-Gloss

¥ Ultra Premium Photo Paper Luster
Photo Paper Gloss 250
Exhibition Fiber Paper
Exhibition Canvas Natural Gloss
Exhibition Canvas Natural Matte
Exhibition Canvas Natural Satin

-l

Singleweight Matte Paper

Singleweight Matte Paper (line drawing)
Presentation Paper Matte

Enhanced Matte Paper

Ultra Premium Presentation Paper Matte

15. Print Mode should always be AccuPhoto HDR (this may gray out, depending on paper).

16. Color Mode must be turned OFF (No color adjustment).

17. Your Output Resolution should be SuperFine — 1440 dpi.

18. Make sure to UN-check High Speed. And make sure Finest Detail is Un-Checked (this is for
vector graphics like text, shapes, etc).

19. Finally, hit the Save Button, which will bring you back to the original dialogue box.

20. Double check that you have completed all the steps. EVERY STEP IS CRUCIAL FOR A GOOD
PRINT QUALITY. Missing a single step may result in various different problems. If there are

problems with your print, check that you have properly completed every step.
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21. Atthe very bottom right of the dialogue box hit: Print.

[_] Match Print Colors Gamut Warning Show Paper White Cancel | | Done | | Print
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Backup

Save master files on at least one external hard drive. Do not save on CD’s or DVD’s because of data
instability and eventual loss of your images. You can save a backup at the time of uploading your images
(see “advanced options” on page 4). However, if you want to save a copy of your edited work, you must
remember to do so at the end of your editing session.

Your instructor will go over file management with you. However, you should not store your work on the
internal drive on the computer. If there happens to be a issue with the computer, IT will re-image it and
this will erase all documents stored on that computer. Also, the remote server (Student Storage) should
be used only for temporary storage (turning in assignments, etc.). This storage is accessible by everyone
on campus, and has no safeguard to someone else deleting or moving your files. Instructors use this
server to collect documents to one location then download to a external drive. These also get deleted at
the end of the semester.

Your own HD is the most secure, it may need to be formatted to use on the Mac or if you use windows at
home it can be foremated to access at both locations. Your instructor can help you with that.
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